HOW TO BUILD MOBILE PRODUCTIVITY APPS FOR IPAD
## TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>WORKSHOP STORYLINE</td>
<td>2</td>
</tr>
<tr>
<td>GETTING STARTED</td>
<td>3</td>
</tr>
<tr>
<td>MOBILE APP DEVELOPMENT: PERFORMANCE TAB</td>
<td>9</td>
</tr>
<tr>
<td>LINKING THE DASHBOARD TABS</td>
<td>10</td>
</tr>
<tr>
<td>REPLACING DYNAMIC AND STATIC TEXTS</td>
<td>12</td>
</tr>
<tr>
<td>DYNAMIC IMAGE BASED ON THRESHOLD</td>
<td>13</td>
</tr>
<tr>
<td>DESIGN OF MAP VISUALIZATION</td>
<td>17</td>
</tr>
<tr>
<td>CREATE A GRID/GRAPH OBJECT</td>
<td>24</td>
</tr>
<tr>
<td>CONFIGURE TRANSACTION SERVICES REPORT</td>
<td>28</td>
</tr>
<tr>
<td>LINKING THE DASHBOARD TABS</td>
<td>29</td>
</tr>
<tr>
<td>CONFIGURE TRANSACTIONS IN THE DOCUMENT</td>
<td>31</td>
</tr>
<tr>
<td>OPTIONAL EXERCISE: ACCESS THE REPORT SERVICE DOCUMENT FROM THE LIBRARY</td>
<td>34</td>
</tr>
<tr>
<td>SHARE REPORT FROM THE IPAD</td>
<td>36</td>
</tr>
<tr>
<td>COLLABORATE WITH MULTIPLE USERS</td>
<td>38</td>
</tr>
<tr>
<td>CONCLUSION</td>
<td>39</td>
</tr>
</tbody>
</table>
WORKSHOP STORYLINE

Finest Foods is a company that sells and distributes products from a wide range of consumer packaged goods (CPG) manufacturers in retail stores across the US. The Regional Account Manager for Finest Foods wants to expand existing relationships and gain new ones to make sure that stores are effectively implementing brand promotion campaigns.

The Vice President of your region has instructed you, the sales operations analyst, to identify each store’s performance and increase the number of promotional campaigns. To do so, you’ll have to analyze the overall performance of the stores in your region. You will first need to identify units sold on a daily basis. Using this data, you can identify high-performing locations, drill down into data to see if a product is being promoted correctly, and ensure that the product is correctly placed in the store. Finally, create a mobile app that arms the Regional Account Manager with the ability to review in-store promotions, capture pictures, and approve campaigns. Your Vice President can consume the document via MicroStrategy Library and collaborate and share with other end users.

GETTING STARTED

Configure your MicroStrategy Mobile app

2. In your iPad device, click on the configuration URL provided in the supporting files. The MicroStrategy Mobile for iPad application will open.

*TIP: MicroStrategy Mobile provides a one-step solution to opening an app via the configuration link. You can create different configuration links for individual users or user groups. Users can also manually configure their app instead of using the configuration link.*

**Launch MicroStrategy Web**

3. Click on the MicroStrategy Web URL to access the mobile dashboard template provided in the supporting files.

4. Login with the following credentials:
   - **Username:** mobileworkshop
   - **Password:** mobileworkshop
5. Open the **iPad Workshop** project:

![iPad Workshop](image1)

**TIP:** Folder browsing makes navigation intuitive and personalized. Users can access objects that relate specifically to their roles and privileges.

7. Click on Shared Reports:

![Shared Reports](image2)

8. Go to the **3. Workshop Templates** folder.
9. Right-click on the **Performance Template** file and choose **Copy**.

10. Click the **up one level** icon next to the drop-down menu and navigate to the **Shared Report** folder.

11. Click the **4. Workshop Development** folder.
12. Click the 📁 icon and create a new folder.

13. Name the folder with your First Name_Last Name and click OK.

14. Name the file “Performance.XY” with your initials replacing XY, click OK.
Note: Remember to type your first and last initials at the end of the file name.

15. Repeat the same steps for the **Promo Review Template** file. Save the copy in the folder you created in the **4. Workshop Development** folder and name it “PromoReview.XY”. Replace XY with your initials.

The picture below shows the two folders created with the corresponding initials.

16. Next, click the back arrow to the **4. Workshop Development** folder and locate the **Performance.XY** template copy you have just created.
MOBILE APP DEVELOPMENT: PERFORMANCE TAB

The following section of the workshop will demonstrate how to develop dashboards for mobile devices using MicroStrategy. We will use the pre-built templates alongside several mobile-friendly components and properties. The components include KPIs, text boxes, background images, grids, and a navigation bar. The finished app is pictured below.

The template designed for this workshop consists of two KPIs and a sample grid for the performance tab. During this session, you will create a dynamic text box that displays a KPI, alongside a dynamic image that displays either an up or down arrow, as well as a customized map. You will also transform the grid into a visually appealing chart.

The **Editable Mode** is shown below
The Design Mode is shown below

**TIP:** In MicroStrategy Web, app designers can build documents in Design Mode as well as Editable Mode. Design Mode offers a full range of document creation options but does not display the actual data, whereas Editable Mode allows you to view the data while you design the document.

To navigate from Design Mode (pencil icon) to Editable Mode (sticky note icon) you can click on the following toolbar icons:

**LINKING THE DASHBOARD TABS**

17. Right-click the copy of the Performance Template document you have created and select **Edit**.
Note: Your document just opened in Design Mode.

18. Right-click the Promo Review icon on the bottom and select Properties and Formatting.

19. Navigate to the Button tab and select the gear icon.

20. To select a target, click the ellipsis button (with three dots) and browse to your copy of the Promo Review.XY template you saved in 4. Workshop Development folder.
21. Click **OK** to save changes.
22. Click **OK** again to save changes.
23. Click **close** to exit the **Properties and Formatting** editor.
24. Save your Document, but do not close it.

**REPLACING DYNAMIC AND STATIC TEXTS**

25. Continue in the **Performance.XY document** in **Design Mode**. In the upper right corner, you can see there are type of texts. Double click in the blue static text **Cost per Unit** and replace it with **Units Sold**.
26. Similarly, double click in the dynamic text named **{[Cost per Unit]}** and replace it by typing **{[Units Sold]}**.

---

**TIP:** If you have your iPad configured, you can check your results anytime you want by browsing to your folder. Be sure to save your file frequently. Go ahead and check your results!
DYNAMIC IMAGE BASED ON THRESHOLD

In this section of the workshop, you will learn how to create images which change dynamically based on a metric value. You will create a symbol that’s dependent on two metrics – Units Sold and Last Year’s Units Sold. In this situation, when the Units Sold metric is larger than Last Year’s Units Sold, an up arrow symbol will be displayed. In the reverse situation, when the Units Sold metric is lower than Last Year’s Units Sold, a down arrow symbol will be displayed. If both metrics are equal, then we will display a constant dot symbol.

**Inputting the Up Arrow Symbol**

27. Click Insert from the toolbar and select Grid.

28. Click and drag inside the workspace to create a blank grid.

29. Drag the Last Year's Units Sold metric from the Dataset Objects panel and drop it inside the newly created grid:
Note: Make sure the yellow horizontal line appears at the top of the box when you are adding the Last Year's Units Sold metric to the grid.

After adding the Last Year's Units Sold metric the grid should look like the following:

30. Click the icon to switch the view to Editable Mode:

Note: You were working in Design Mode until now. You will now switch to Editable Mode for different views and formatting options.

31. Right-click the grid and select Properties and Formatting.
32. Select the Layout tab from the Properties menu.
33. Set the Position to Left: 843 Pixels and Top: 97 Pixels.
34. Set the Size to 100 Pixels for both width and height.
35. Navigate to the Grid tab in the Properties menu. Unselect the Rows – Show and Columns – Show options. Make sure that your settings are as following:

36. Switch back to Design Mode by clicking the icon in the toolbar.
37. Right-click the previously created grid and choose **Thresholds → Advanced**.

*Tip: Thresholds are an easy way to highlight specific information that you want the users to see. You can use different colors and fonts to help certain metrics “pop,” or you can replace entire text fields with an image of your choice.*

38. Select the **Units Sold** metric from the **Filter On** drop down.

39. Select **Greater than** from the next drop-down list.
40. Click the **Select Metric** button and choose **Last Year's Units Sold** from the drop-down list and click **Apply**.

41. Double-click on the white rectangle on the right.

42. Select the **Replace Data** box and choose **Image** from the drop-down list.

43. In the blank text box type “./images/assets/threshold_up@2x.png” and select **OK** to apply the changes.

44. Click **save** icon to save the document.

**TIP:** You can preview your threshold in the iPad to see the KPI metric and thresholds you created.

**DESIGN OF MAP VISUALIZATION**

45. Drag the **Store, Store Latitude, Store Longitude** attributes, as well as **Profit Margin**, and **Revenue** metrics from Dataset Objects and drop it on the grid below the Profit Margin title.
**TIP:** MicroStrategy automatically maps the columns as attributes (your business dimensions) and metrics (your performance indicators or KPIs) that are available for analysis. This mapping is based on the column data types and content.

46. Right-click in the grid. Navigate to **Properties and Formatting**. Under Properties click **Widget**.

47. Under **Widget** Section, click on the drop-down menu. Navigate to **Mobile**, and then to **Map**.
48. Navigate to the Widget tab in the Properties menu and click on Widget Properties.

49. Select the Use bubble markers option on Map Properties and set Maximum bubble size to 40.
TIP: The bubbles option is useful for displaying two metrics at once in a single map. One metric can impact the size of each bubble and the other metric can change the color of each bubble.

50. Choose Use Attribute from Use Attribute or Form.
51. Select Latitude / Longitude in the Select data type form.

52. Choose Store Latitude and Store Longitude in the Select latitude and Select longitude drop-down lists.

53. Select Store in the Selection display attribute drop-down list.

54. Select Esri from the Base map drop-down list.

**TIP:** MicroStrategy provides parity between Web and Mobile for seamless geospatial analysis. Users can build map visualizations using ESRI or Google on Web and instantly view them rendered on native mobile maps, i.e. Apple Maps on iOS.

55. Click OK to accept the changes. Click OK again to close the Properties and Formatting menu.

56. Right-click on the grid and select Thresholds ➔ Visual.
57. Click on **Type: Lowest %** to bring up two drop-down lists. Select **Revenue** from the **Based on:** drop-down list.

58. Click the button to add a threshold.

59. Drag the button to the left and set the threshold to 33%.

60. Hover over the scale and click on the **add threshold** icon.

61. Double-click in the area to the left of 33%.
62. Click on the Format icon, and navigate to the Color and Lines tab, select the color drop down, and select More Colors from the Color drop-down list. Set the fill color to Red: 224, Green: 15, and Blue: 0.

![Color and Lines Icon and More Colors Button]

63. Click OK to accept changes. Click OK again to close the Format window.

64. Similarly, for the area between 33% and 67% on the scale, set the fill color to Red: 230, Green: 191, and Blue: 0.

65. For the area to the right of 67% on the scale, set the fill color to Red: 117, Green: 209, and Blue: 117.

66. Press the button to exit the threshold editor.
67. Click icon to save the document.

**TIP:** Users can add multiple map layers in ESRI and Google Maps. Each layer is configured independently and can be viewed in a single visualization.

---

**CREATE A GRID/GRAH OBJECT**

In the template of the Performance tab there is a prebuilt grid named **Weekly Units Sold**. It consists of the **Category** and **Day** attributes and the metric **Units Sold**. In this part of the workshop you will learn how to create a view filter to limit the data shown on a grid or graph. You will also learn how to transform a grid into a visually appealing graph by using **Quick Switch**.

60. Right-click on the grid below the **Weekly Units Sold** title and choose **Edit View Filter**.

61. Click the green plus icon to add a new condition to filter in the grid.
62. In the **Based on** column choose the **Day** attribute.
63. Select the **In List** qualification in the next column.
64. Select **any five days** in the next column. For instance, you can choose the last five days of the month.

65. Click the blue check mark icon 🔄 to add new qualification.

66. Click **Save** to accept the changes.

67. Right-click the **Weekly Units Sold** grid and select **Properties and Formatting**.

68. Navigate to the **Layout** tab and click the **Quick Switch** box to select it.
69. Click **OK** to save the changes.

**TIP:** **Quick Switch** is a feature in MicroStrategy that enables users to quickly switch a grid into a graph. Thanks to this option, it is possible to easily switch the view on mobile devices by pressing the **Quick Switch** icon on the grid or graph.

70. Click on the grid to select it, and then click the chart icon on the graph toolbar to switch the grid to the graph.

**TIP:** By clicking the icon you will switch the prebuilt grid to a horizontal bar chart. However, there are numerous chart types available in MicroStrategy. Among others, you can create bubble graphs, heat maps, line charts, maps, pie charts, or combo charts (which are a combination of a bar chart and a line chart).

68. Click on **Graph** on the toolbar and Click on the icon to switch to Editable Mode.

69. Right-click the **Weekly Units Sold** graph and select **Format**.

70. Navigate to the **Format** tab and choose **Series Shapes** from the first dropdown list.
71. Click on the **Color**: drop-down list and select **More Colors**.

72. Set the fill color by entering **005A8B** in the **Hex**: window. Click **OK** to save the changes.

73. Select **Bar Riser for Beverages** from the second drop-down list:

74. Set the **Fill Color** to **0098EB**.
75. Repeat the previous step for **Bar Riser for Coffee & Tea** with color – 74D174 and for **Bar Riser for Snacks** with color – E5BD00.

76. Click **OK** to accept the changes. Click **OK** again to close the Format Window.

77. Click **Save** icon to save the document.

78. To exit the document, click the **Exit** icon.

---

**TIP:** MicroStrategy Mobile enables developers to make updates and publish changes without the need to recompile and redistribute apps. You can now access the Performance tab you developed, instantly in your iPad devices.

---

**CONFIGURE TRANSACTION SERVICES REPORT**

In this section of the workshop you will learn how to configure a Transaction Services Document. Start by opening the **Promo Review** Template document in your folder. When you open this report, you will see that it has two main parts: the panel on the left will serve as your transaction input while the grid on the right will show the data you have submitted.
The left-hand panel consists of two panel stacks. One is already preconfigured and provides the photo uploader functionality. The other panel stack is empty, and we will configure the second part of the transaction here. Below you can find the dashboard tab you will be developing.

Note: During this workshop, all participants are using the same MicroStrategy login, as a result, you will see everybody else’s input. In a real-life implementation, it is possible to filter the grid so that it shows only your records or those of your team members if you are a manager.

**TIP:** MicroStrategy Transaction Services embeds write-back functionality into documents and dashboards for the purposes of decision making or initiating a transaction. Users can interact with their data to approve requests, submit orders, change plans, and capture information such as updating data and images in ERP systems, CRM systems, and operational databases.

**LINKING THE DASHBOARD TABS**

79. Save and close the **Performance.XY** document.

80. Now, right-click and edit the **PromoReview.XY** file in the **4. Workshop Development** folder.
81. Right-click the Performance icon on the bottom and select Properties and Formatting.

82. Navigate to the Button tab and select the gear icon.
83. Click the ellipsis button with three dots and browse to your copy of Performance.XY template in your folder 4. Workshop Development.

84. Click OK to save changes. Click OK again to save changes and exit the editor.

85. Click Close to exit the Properties and Formatting editor.

_TIP:_ To build transaction-enabled documents, users can leverage a wide range of transactional input forms and a flexible drag-and-drop design template. Users can change and add new data using text and number inputs, calendar, camera, GPS, switches, steppers, and sliders.

**CONFIGURE TRANSACTIONS IN THE DOCUMENT**

86. Right-click in any of the text boxes in the document and select Configure Transaction.
87. Set the Transaction Input to: `display_rate@ID`, and the Field to: `quality rating input`.

88. Tick the **Editable** box next to the **Field** drop-down list.

89. Select the **Star Rating** control style from the drop-down list on the right.

90. Click the gear icon 🌋 in the same line.

91. Select the **Input is required** box, the **5-star** maximum rating value, and the **blue** display style of stars.
92. Set the Transaction Input to: `correct_location@ID`, and the Field to: Correct Location Input.

93. Select the **Editable** box next to the **Field** drop-down list.

94. Select the **Switch** control style from the drop-down list on the right.

95. Select the gear icon 🏞️ in the same line.

96. Select the **Input is required** box.

97. Set the **Off value** to “0” and **On value** to “1.”

**Note:** The input for the Correct Location is set to 1 or 0, however in the Review Submissions table values are displayed as “Yes” or “No.” This happens because of the prebuilt threshold which assigns “No” to 0 and “Yes” to 1.

98. Set the field next to `signature@ID` to Acknowledge Input.

99. Select the **Editable** box next to the **Field** drop-down list.

100. Select the **Signature Capture** control style from the drop-down list on the right.
101. Select the gear icon 🔄 in the same line.

102. Select the **Input is required** box and the **Show guidelines** box.

103. Select **OK** to apply the changes.

104. Save the document.

105. Now you can view the document in the iPad!

**Note:** The grid on the right side of **Promo Review** tab presents all entries which have been added using the transactions you have just developed. The grid is displaying a miniature version of the uploaded image, its rate, information about correct location, and the preview of the signature.

---

**TIP:** You can preview uploaded images in the Promo Review tab simply by clicking the image on the grid on the right side. The preview is created in MicroStrategy through an Information Window.

---

**OPTIONAL EXERCISE: ACCESS THE REPORT SERVICE DOCUMENT FROM THE LIBRARY**

The MicroStrategy Library is a personalized portal for each end user to access Report Service Documents and Dossier.

106. Right-Click on your **Performance.XY** document and select **Share**.
107. In the Share window, select **Library Link**.
108. Click on **Email Link And email this link to your iPad.**
109. Then, click **Launch**.

![](image1)

110. A new browser will open.
   Enter credentials:
   Username: mobileworkshop
   password **mobileworkshop**.

111. Click **Add to Library**.

![](image2)

112. Click in the upper left button, **Library**. A new page will open.

![](image3)

113. You can now consume your Document on Web via **MicroStrategy Library**.

![](image4)
SHARE REPORT FROM THE IPAD

With MicroStrategy Library, you can easily share a link that gives other developers and analysts the ability to modify the app, or provide consumers with view-only links that lets them add it to their own MicroStrategy Library. Links can be shared via email, chat, or direct invite.

114. Click on the link you sent to your email in your iPad.
115. A new Browser will open. Enter the credentials in the MicroStrategy Library.
   **Username**: mobileworkshop
   **Password**: mobileworkshop

116. Click Open in app.

117. Enter the credentials again.
118. Click in the arrow icon located in the upper right side of the iPad screen.

119. Click in the **Share** icon. Select **Invite Users**.
120. In the **View selected** window, type “Mobile” and select **mobileworkshop**. Click the blue **Invite** button.

![Invitation to mobileworkshop](image)

121. Your invitation was sent to **mobileworkshop**.
Optional: Collaborate with your peers in the room and invite one of the name provided to you.

**COLLABORATE WITH MULTIPLE USERS**

By supporting a range of collaboration features, MicroStrategy Documents make it even easier for teams to work together. Users can ask questions, highlight trends by commenting directly with the Document interface. Tagged users can receive notifications via browser, email, badge icon, and iOS push notifications.

122. Click on the **Comment** icon. Tag someone in the organization by typing @+user_name with the message “App-up-to-date” And click **Post**.
123. You will notice the comment will appear below in the text box, creating a thread of communication between users.

CONCLUSION

Congratulations! You have completed the How to Build Mobile Productivity Apps for iPad Workshop! Check your MicroStrategy Mobile App and MicroStrategy Library App in the iPad to analyze performance, review the promotions, share, and collaborate with users.

For further MicroStrategy Mobile information, including resources and certifications in the MicroStrategy Community, please visit:

https://www.microstrategy.com/us/services/education/